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1 What does MAXQDA Stats offer? 

MAXQDA Stats is a stand-alone statistics module that accompanies MAXQDA software, providing 

frequently used descriptive and inferential statistical methods. MAXQDA Stats is now available with 

two great features: 

1. Link and interact with data from a MAXQDA project 

MAXQDA Stats can be called up for the data of a MAXQDA project, so the document variables and 

code frequencies per document can be transferred to Stats. The documents that are in the statistical 

results tables behind individual cells can be stored as document sets for further qualitative analysis. 

When MAXQDA Stats is closed, variables which may have been added or modified can be transferred 

back into the MAXQDA project with the qualitative data. 

2. Interactive results table 

MAXQDA Stats results tables are dynamic, meaning they can be adapted and interactively edited. 

Rows and columns can be deleted or merged, and the results table will be automatically recalculated. 

Columns can be moved, hidden or sorted – changes in the results table can be undone. Cells that 

contain significant values or sharply outlying values can be highlighted in color. 

With MAXQDA Stats you can: 

● Analyze data from MAXQDA projects 

● Analyze external data from SPSS or Excel, for example online surveys 

● Enter and analyze new data, for example from “Paper and pencil” surveys 

In Detail MAXQDA Stats offers the following functions: 

● Statistical analysis of document variables and code frequencies for MAXQDA projects 

● Statistical analysis for external data in SPSS or Excel format 

● Export data to SPSS or Excel 

● Interactive results table in which rows and columns can be moved, deleted or merged 

● Exclude cases listwise for individual calculations 

● Calculate new variables from existing variables 

● Calculate and store z-standardized values for a variable 

● Recode variables into new or existing variables 

● Filter and search datasets 

● Navigable output viewer, from which content can be exported, copied or printed 

● Export editable result tables to Word via the clipboard 

MAXQDA Stats can perform the following procedures and calculations: 

● Frequency tables 
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● Descriptive statistics: Mean, standard deviation, variance, median, quartiles, minimum, maxi-

mum, range, sum, standard error, 95% confidence interval for the mean 

● Crosstabs: absolute and relative frequencies, row and column percentages, expected frequencies, 

residuals, standardized residuals, adjusted standardized residuals; Chi-square, Phi, Cramer’s V, 

contingency coefficient C 

● One-way analysis of variance: with output descriptive statistics and Levene test of homogeneity 

of variance 

● Correlation: Pearson and Spearman correlation 

● Scale: Cronbach’s Alpha 

Hint: These instructions are not intended as a statistics tutorial and explain computed values only to 

highlight specific features. To better understand the statistical calculations, we recommend you refer 

to your available statistical literature. 
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2 Using MAXQDA Stats 

MAXQDA Stats as part of “MAXQDA Analytics Pro” 

MAXQDA Stats is a module that is part of the product “MAXQDA Analytics Pro”. It cannot be pur-

chased individually and can only be unlocked with a corresponding MAXQDA serial number. If you 

use a license for “MAXQDA Analytics Pro,” the menu item Stats from which MAXQDA Stats can be 

started appears on the MAXQDA main menu to the left of the Help menu. 

 

The MAXQDA Stats menu 

The MAXQDA Stats interface 

MAXQDA Stats can be activated with both the data of a MAXQDA project (document variables and 

code frequencies per document) and with external data (SPSS or Excel files). Upon starting, the 

MAXQDA Stats interface, which is structured as follows, appears: 

 

The MAXQDA Stats interface 

Hint: When MAXQDA Stats is activated, the normal MAXQDA interface is no longer visible. It will 

automatically appear again when MAXQDA Stats is closed. 
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MAXQDA Stats has its own main menu which contains the following options: 

File – this menu item serves to open files, create new files, and store external data 

View – this menu item allows the user to switch between the Data Editor, Variable List and output 

viewer 

Transform – contains all the functions for calculating and recoding variables 

Descriptive Statistic – contains the functions for the creation of frequency tables and calculating 

descriptive statistics such as median, mean and standard deviation 

Compare Groups – allows the creation of crosstabs and the implementation of one-way analysis of 

variance 

Correlation – begins the calculation of correlation tables 

Scale – provides access to the functions for creating scales 

The user can easily switch between views using the tabs located in the lower left of the screen. 

The Data Editor contains the cases in the rows and the variables in the columns. This is where the 

individual cases (analysis units) are entered and edited. If MAXQDA Stats is started for a MAXQDA 

project, the Data Editor for MAXQDA Stats will contain the same data as the Data Editor for document 

variables as the MAXQDA project, meaning each row corresponds to one document. 

In the Variable List variable labels, missing values and other options for variables can be created. 

The Output Viewer contains all the results tables and charts that were inserted in the Viewer in the 

course of the MAXQDA Stats session. 
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3 The Data Editor  

The MAXQDA Stats Data Editor displays the cases in the rows and the variables in the columns. Each 

case is therefore in a separate line. The following figure shows the Data Editor for a MAXQDA project, 

which essentially correponds to the Data Editor for the MAXQDA document variables. The first row 

provides information on the document “RESP002” which contains 6 coded segments and 0 memos. 

It refers to a survey respondent that is widowed, has a high job security level and is between 70 and 

79 years old. 

 

The MAXQDA Stats Data Editor 

The first four columns in the example figure contain the MAXQDA system variables “Document 

group”, “Document name”, “Number of coded segments” and “Number of memos”. They are im-

mutable in MAXQDA Stats and column headings are therefore shown as known from MAXQDA in 

black. The modifiable user variables are shown in blue. 

Individual columns can be hidden by right-clicking on the column header and choosing Hide column 

from the context menu. Using the Select columns function, also in the context menu, individual or 

all columns can be hidden or shown, just like in MAXQDA. 

Hint: The order of the columns from left to right cannot be changed, as this order always corresponds 

to the order of the variables in the Variable List from top to bottom. 

System Defined Missings 

MAXQDA Stats considers any blank fields in the Data Editor as system-defined missing. Unlike in the 

MAXQDA Data Editor, integer or floating point-type variable fields can also be empty. 
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Show Value Labels  

The toolbar is located above the Data Editor on the left side. 

 

Toolbar on the left side of the Data Editor 

Using the icon Show value labels  the entered value of the value label will be displayed. This value 

can be individually defined for each variable in the Variable List. If no label is defined for a value, the 

value will still be displayed. 

Sort, Search and Filter Cases 

Clicking on a column header in the Data Editor sorts the data in this column; clicking a second time 

sorts the same column in the reverse order. 

Hint: On the left side of the Data Editor a sequential numbering of the rows is displayed. The num-

bering is fixed in order to provide orientation in the dataset; it will not be sorted. For external files, it 

is always advisable to provide a variable with a unique case ID. 

The Data Editor in MAXQDA Stats can be searched and filtered, exactly as in MAXQDA. Clicking on 

the Search  icon in the toolbar above the Data Editor opens a search list in which a search query 

can be entered, the occurrence of which will be searched in all columns. To search in a single column, 

right-click on the column header and select Search. 

The filter function can similarly be called up for a column as follows: 

1. Right-click on a column header. 

2. Select Filter. 

3. In the dialog box, define a filter criteria and click OK. 

 

Enter filter criteria 
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The number of cases currently in the Data Editor can be seen in the bottom right of the status bar. 

Only these cases are included in the calculations. 

To switch the currently set filter on and off, click on the Filter  icon in the toolbar above the Data 

Editor. To delete all filters, click on the  icon. 

Go to Case  

To jump to a particular case in a row, click on the  icon in the toolbar above the Data Editor. A 

small dialog box will appear where you can enter the target row. 

Insert New Cases  

When MAXQDA Stats is called up for a MAXQDA project, it is not possible to insert new cases, as 

this would be synonomous with the insertion of further documents in the MAXQDA project itself. 

The situation is different when you create or open a new external file. In this instance, it is of course 

possible to add additional cases to the data set, which can be done as follows: 

1. Scroll to the bottom of the data set 

2. A blank row is located in the last row of the Data Editor. As soon as any content is entered in any 

column, this row will be assigned a consecutive number and another blank row for the next record 

will appear underneath the previous row. 

Delete Cases 

When you work with an external file in MAXQDA Stats, you can delete individual or multiple cases as 

follows: 

1. In the Data Editor, highlight a single case with the mouse, or highlight multiple cases by 

pressing the Ctrl/cmd key. 

2. Right-click the highlighted area and select Delete selected cases. Alternatively, you can click 

on the Delete icon  in the toolbar above the Data Editor. 

Export Data Editor 

At the top right of the Data Editor a typical MAXQDA toolbar is located, which contains the following 

icons for exporting data. 
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  Open as Excel table – When you click on this icon, the current view will be displayed as a tem-

porary Excel file. If you wish to save this file, you must do so in Excel. Value labels that are displayed 

in MAXQDA Stats will also be displayed in Excel. 

  Open as HTML table – When you click on this icon, the current view will be displayed as a 

temporary HTML file in the default browser. If you wish to save this file, you must do so in the selected 

browser. Value labels that are displayed in MAXQDA Stats will also be displayed in the HTML file. 

  Export – When this function is selected, a file dialog will appear in which you can select from 

Excel or HTML export formats and specify a file name and location. The file will open automatically 

following the export process. Value labels that are displayed in MAXQDA will also be exported. 

The currently displayed data can be saved as an SPSS file by selecting File > Save as from the main 

menu. 
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4 The Variable List  

The MAXQDA Stats Variable List allows you to manage all the variables of a data set. This is the place 

to define the variable names and value labels, and also to set missing values for a variable. New 

variables can also be created in the Variable List. 

 

The Variable List in MAXQDA Stats 

In the first column there is a consecutive numbering of the variables. The variables in the Data Editor 

are displayed from left to right, corresponding to this numbering. The number of variables in the 

current data set are displayed on the bottom right in the status bar. 

The other columns include the following features: 

Variable – This column is a mandatory column, meaning each variable requires a variable name. To 

create, for example, a frequency table or a crosstab, you can select the name of individual variables. 

Hint: In MAXQDA Stats variable names can be composed of any character strings up to 63 characters 

in length. Unlike in many statistics programs, spaces and any special characters are permitted. When 

working with external statistics files (SPSS, STATA, etc.). it is advisable to choose simple variable names 

to ensure compatibility. When saving a data set in SPSS format, the variable names are automatically 

adjusted to be SPSS-compliant. 

Variable label – In addition to the variable name, it is possible to assign a label to a variable. In 

MAXQDA this label can be up to 255 characters in length and include any characters. The variable 

label will appear in selection dialogs and results tables in the place of the variable name for easier 

interpretation.  

Variable type –The same types of variables can be used in MAXQDA and MAXQDA Stats: text, 

integer, floating point, date/time, and Boolean (true/false).  

Value labels – In statistical data sets, answers are often coded with numbers, for example 1 for 

“low” and 4 for “high”. Assignment of texts to the encoded numbers is done via value label and will 

appear in this column. At the top of the figure it is shown that for the marked variable “Q.1. Job 

Security Scale” the text labels “low” and “high” were assigned for the scale endpoints 1 and 4.  
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Missing values – In this column, the values are displayed which are to be counted as missing for the 

respective variable and therefore not to be included in the analysis. 

Hint: Please note that for the variable type "Boolean" no missing values can be defined. 

Measure – Here you can set the measurement level of a variable. You can choose between three 

levels: “Interval”, “Ordinal” and “Nominal”. 

Source – This column provides information about the origin of a variable. Variables automatically 

generated in MAXQDA carry the identifier “System”, user-defined variables carry the identifier 

“User”. Variables with the origin “Code” are codes to which the function “Transform into document 

variable” was applied in a MAXQDA project. Variables carrying the identifier “Dictio” are the result 

of a dictionary-based enumeration of category frequencies using MAXDictio. 

Hint: The colors of the squares in the leftmost column of the Variable List reflect the origins of the 

variables (User = blue , System = red , Code = green ; Dictio = yellow). When working with external 

files, only blue squares are displayed, as all variables were created as freely editable User variables. 

To be displayed – From this column, you can control the display of variables in the Data Editor. To 

hide a column, remove the check mark by clicking a cell. 

Sorting the Variable List 

Click on a column header to sort the list of variables corresponding to the clicked column. To restore 

the original order, click on the first column with the numbering. 

To adjust the order of the variables, follow these steps: 

1. If the first column is not sorted in ascending order, first click the first column header to reset the 

currently used sort. 

2. Now you can move individual variables by clicking in any row and moving the row to the desired 

location. To move multiple rows at the same time, hold down the Ctrl or Cmd key as you click on 

the desired rows, then drag the multi-row highlighted area with the left mouse button. 

Create New Variables  

You can create new variables by entering data in the blank, bottom row of the Variable List: 

1. Double click in the last blank row of the “Variable” column. MAXQDA Stats will automatically 

generate a new generic variable name: “var001”, “var002” etc. 

2. Enter a new variable name in the “Variable” column and provide a variable label as required. 

3. In the “Variable Type” column, select one of the five variable types supported by MAXQDA Stats, 

which are the same as those supported by MAXQDA: 

● Text 
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● Integer 

● Floating Point 

● Date/Time 

● Boolean (true/false) 

The new variable is created once you have clicked on a location outside the row and this row is no 

longer highlighted. Data can now be entered in the Data Editor. 

Hint: The variable type of a previously created variable can be changed under certain conditions 

(see below). 

If required, enter data in the columns “Value Labels,” “Missing Values,” and “Measure.” 

A toolbar is located above the Variable List on the left: 

 

Toolbar on the top left above the Variable List 

Click on the icon New variable  to automatically jump to the last row of the Variable List, where 

you can immediately start typing a variable name. 

Copy Variables  

Copying variables can be very helpful, particularly when defining multiple nearly identical variables in 

an item set or matrix question: 

1. Highlight one or more variables by clicking on the appropriate row or clicking and holding 

the Ctrl/cmd key to select multiple rows. 

2. Right-click on the highlighted area and select Copy variable or press Ctrl+C (Windows) or 

cmd+C (Mac). 

3. Right-click on the target line and select the function Insert variable above. 

When the variable is copied, the variable Label, variable type, value label, missing values and measure 

will be copied, however the values will not. 

Define Value Labels  

Value labels are used to match a text to a numerical variable value. For example, if the endpoints of 

a response scale to the question “Safety of your workplace” are coded with 1=”Low” and 4=”High”, 

these responses can be switched between their numerical and text representations in the Data Editor. 

By clicking a cell in the Value Label column, the following dialog box will appear. 
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Dialog box for creation of a Value Label 

In the left hand column, enter the value to be associated with the label on the right. Normally the 

value is a number, but you can also use any text string, for example “f” for “female” or “Man” for 

“Manager.” When you click OK the value label will appear in the appropriate cell in the Variable List. 

Using the two Delete icons at the top of the window, you can delete single or all entries. 

Define Missing Values  

There are many reasons why missing values may be present in a data set: A respondant did not answer 

a question or refused to answer a question, or their response is not clear, for example in a handwritten 

questionnaire an X was placed exactly between two responses. To denote missing values, there are 

two main options: a) The data field is left blank, in which case the missing value will be considered 

“System defined missing” and ignored in the evaluation, or b) A specific value can be provided to 

interpret the missing value. 

To define a missing value, click in the cell of the missing value to call up the following window: 

 

Window for entering a missing value 
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In this window, single missing values or a range of missing values can be entered. All entries in the 

window are always considered; for example, in the above window, the 99th values as well as the 

values from -3 to 0, inclusive, will be ignored in the evaluation. 

Hint: Missing values cannot be defined for “Boolean (True/False)” variable types. 

Search and Filter Variables 

The Variable List in MAXQDA Stats can be searched and filtered exactly as in MAXQDA. Clicking on 

the Search  icon in the toolbar at the top of the window opens a search list in which a search query 

can be entered, whose occurrence will be evaluated in all columns. To search in a specfic column, 

right-click the column header and select Search. 

Likewise, the filter function can be applied to a specific column: 

1. Right-click on the column header. 

2. Select Filter. 

3. Enter the filter criteria and click OK. 

 

Enter filter criteria 

The status bar at the bottom right of the window displays the number of variables that fulfill the 

selected criteria. 

To turn the filter off and on as required, click the Filter  icon in the toolbar above the Data Editor. 

By clicking the  icon, all filters will be deleted. 

Binarize or Transform Variables into Text Variables 

To binarize one or more variables, proceed as follows: 

1. Select single or multiple “Integer” or “Floating point” variables with the mouse. 



The Variable List 18 

2. Click the Transform into binary variable  icon in the toolbar above the Variable List and con-

firm the query. 

Therein the variable will be transformed into type “Boolean”, in which all values different from 0 are 

set to “false” – including the missing values or defined missing values. 

 

Toolbar at the top left of the Variable List 

The Transform into text variable  icon allows you to transform all highlighted (non-text) variables 

into “Text” type variables. 
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5 The Output Viewer  

In the Output Viewer, all calculated and customized results tables and charts can be stored. The 

Output Viewer is divided into two sections: on the left is a tree directory where you can jump directly 

to the contents; on the right the results tables and charts are displayed. 

 

The Output Viewer 

Clicking on an entry in the directory tree jumps to the corresponding location and highlights the 

appropriate table or chart as well as the correponding heading. 

Export Output Viewer  

Single or multiple contents of the Output Viewer can be exported or copied to the clipboard. 

Copy Highlighted Tables and Charts to the Clipboard 

You may wish to copy tables and charts into word processing software such as Word, or presentation 

programs such as PowerPoint. There are several ways to do so. 
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● Right-click on an object you wish you export in the directory tree of the Output Viewer and 

select Copy selection to clipboard. When you select a heading, all corresponding objects will be 

automatically selected and copied. 

● Click on an object in the directory tree, then click Copy selection to clipboard  in the top left 

of the window. 

● Highlight the desired selection in the Output Viewer with the mouse, then right-click the high-

lighted area and select Copy selection to clipboard. 

 

Copy objects from the Output Viewer to the clipboard 

Export Complete Contents 

Using the symbol in the top right of the window, you can export the Output Viewer in HTML format: 

  Open as HTML table – Clicking on this icon displays the contents of the Output Viewer in a 

temporary HTML file in the default browser. To store the file, you must save it from the browser. 

  Export – When you select this function, a dialog box will appear in which you can select the 

filename and location in which you wish the file to be saved. The file will open automatically following 

the export process. 

Print Output Viewer  

Click the Print icon or use the keyboard combination Ctrl+P (Windows) or cmd+P (Mac) to print 

the contents of the Output Viewer. In the dialog box that appears you can select from multiple page 

settings and select the printer. 
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Print window 

Hint: Please note that very large tables may be cut on the right side when printed. 

Delete Content from the Output Viewer 

To delete content from the Output Viewer, right-click an entry in the directory tree and select Delete 

or use the Delete key (Windows) or cmd+Backspace (Mac). 

Clicking the Clear output viewer  icon at the top left of the window empties the entire Output 

Viewer. 

Hint: When you close MAXQDA Stats the contents of the Output Viewer will automatically be de-

leted. If you wish to save the contents of the Output Viewer, you must export or copy them to the 

clipboard before exiting the program. 
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6 Analyze Variables and Codes from a MAXQDA 

Project 

Starting MAXQDA Stats 

MAXQDA Stats offers a convenient and innovative way to statistically analyze the document variables 

of a MAXQDA project as well as the code frequencies per document. With MAXQDA Stats, you can 

eliminate the cumbersome process of exporting data to a statistical program and then transferring it 

back to MAXQDA for further analysis; instead, your statistical analyses can be performed directly 

within the stats module. 

Upon starting MAXQDA Stats, the document variables and code frequencies per document are auto-

matically transferred in the following manner: 

● The documents form the cases in the Data Editor, exactly as in MAXQDA. Each document is in a 

separate row and can be identified by its document name and document group. 

● The document variables from MAXQDA form the columns in the Data Editor and can be adapted 

and supplemented in the Variable List. 

● A code frequency matrix, in which documents form the rows and codes form the columns, is 

transferred to the background and is available for analysis. MAXQDA Stats shows how often a 

selected code was assigned in a document for each case (therefore in each document). You can 

envision that in the Data Editor, further (invisible) columns are present whose cells contain the 

code frequency per document. 

 

The Data Editor: rows are formed by documents, columns are formed by variables 

Hint: When working in MAXQDA Stats, the document variables and code frequencies of the 

MAXQDA project will not be affected. Upon exiting MAXQDA Stats, newly created variables and 

modified variable values can be transferred back into the MAXQDA project. 
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To start MAXQDA Stats for a MAXQDA project, several options are available in the main menu under 

the entry Stats: 

 

Starting MAXQDA Stats from the MAXQDA main menu 

● Start Stats with all documents – When this option is selected, all documents will be available as 

cases for statistical evaluation in Stats. 

● Start Stats with activated documents – This option is useful when evaluations should not be 

carried out for all documents, for example, when only documents with the transcripts of respond-

ents in MAXQDA Stats are to be evaluated, and documents with their own notes or Twitter imports 

should be left out. Before calling up this function, activate the documents to be analyzed. 

● Start Stats with activated documents and codes – This option is designed especially for the 

event that you have a very large code system, but are only interested in selected code frequencies 

per document. To use this feature, first activate the desired codes and documents that are to be 

analyzed in Stats. 

Hint: MAXQDA Stats is limited to 1,000 different variables and codes. If a MAXQDA project contains 

more variables and codes, only the first 1,000 variables and the first codes in the code tree will be 

transferred to MAXQDA Stats. 

The transfer of document variables from MAXQDA when starting MAXQDA Stats occurs in the fol-

lowing manner: 

● If a label, value label, missing value or measurement level for a variable has already been created 

in MAXQDA Stats, this information will be available the next time you start MAXQDA Stats. The 

specifications are written into the project file and remain there even if MAXQDA Stats is closed 

and reopened at a later time. 

● If a missing value is defined for a variable in MAXQDA, it will be transferred as the first missing 

value in the top left of the “Missing Values” window in MAXQDA Stats, so long as this position is 

empty. If the first value is already defined in Stats, no value will be transferred from MAXQDA. 

● Missing values for Boolean variables are not accepted, because no missing values for these varia-

bles can be defined in MAXQDA Stats. 

● Depending on the type of variable in the case that the “categorical” option has been set for a 

variable in MAXQDA, the measurement level in MAXQDA Stats is set for the variable. Text and 

Boolean variables get the measurement level in nominal terms, as categorical integer and floating 

point variables. Other numerical variables and date variables are associated with the level of “in-

terval”. If the measurement level has been changed in Stats, it will remain unmodified the next 

time MAXQDA is launched. 
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When data from a MAXQDA project is transferred to MAXQDA Stats, all Stats analysis functions 

remain available. 

Transfer MAXQDA Stats Data to a MAXQDA Project  

After completing the analysis in MAXQDA Stats, modified variable values can be transferred back to 

the MAXQDA project to update the existing variables and add new ones. Likewise, document sets 

created during the analysis can be transferred. 

In principle, the transfer of variables from MAXQDA Stats to the MAXQDA project occurs in exactly 

the same manner as when data is read in MAXQDA using the Import data (document variables) 

function. 

To transfer MAXQDA Stats data to the MAXQDA project, close the MAXQDA Stats window using the 

X symbol (Windows) or red X symbol (Mac) at the top of the window or by selecting File > Quit 

MAXQDA Stats from the Stats main menu. The following option window will appear: 

 

Options window for closing MAXQDA Stats 

Update and insert document variables to the MAXQDA project 

In the upper pane two options are available, which are selected by default and allow you to control 

the transfer of variables from Stats for the document variables of the MAXQDA project when exiting 

Stats. 

Update document variables of MAXDA project – If this option is selected, the values of all varia-

bles whose names already exist in the MAXQDA project (and which are also the same variable type) 

will be updated. The definition of missing values and the “categorical” property of a variable cannot 

be changed during transfer. Existing document variables that were created from a code using the 

“Transform into variable” function will not be modified, because they always reflect the current code 

frequencies and are dynamically updated in MAXQDA. 
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Insert new document variables in MAXQDA project – If this option is selected, variables whose 

names do not yet exist in the MAXQDA project will be inserted, and the variable values of the indi-

vidual documents will be transferred. 

Hint: If a variable from Stats has the same name as a document variable that already exists in the 

MAXQDA project but is a different variable type, it will be inserted into the MAXQDA project as a 

new variable with a suffix. For example, if a numerical variable with the name “Education” is trans-

ferred to the MAXQDA project, in which a text variable also entitled “Education” already exists, a 

new variable with the name “Education (2)” will be inserted. 

In MAXQDA Stats, variables indicated in green which were created from codes using the “Transform 

into document variable” function will not be transferred to MAXQDA, even if their names are modi-

fied. 

Transfer document sets to a MAXQDA project  

In the MAXQDA Stats interactive results tables, it is possible to create a document set that contains 

exactly the documents represented by a cell or a row. MAXQDA Stats remembers all of the document 

sets created over the course of the analysis and lists them in the lower pane of the dialog box displayed 

above when you close MAXQDA Stats. You can individually select whether each document set should 

be inserted into the MAXQDA project. 

For example, in the image below the set “Marital Status * Age Group (married * 20-29)” was created 

in a crosstab and contains exactly 8 documents that come from married respondents aged between 

20-29 years. After the transfer of the Stats data to the MAXQDA project, all selected document sets 

will appear in the “Document System” window. 

 

Inserted document sets in the “Document System” window of a MAXQDA project 
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Save Variables and Code Frequencies as SPSS Data  

Even when MAXQDA Stats is launched with the data from a MAXQDA project, the data matrix in-

cluding the variable definitions can be saved in SPSS format, which can be read by lots of statistical 

packages: 

1. Select the menu function File > Save as and choose a filename and location in the dialog box that 

appears. 

2. MAXQDA Stats will ask if you also wish to export the codes to SPSS. If you answer yes, each code 

that is available for analysis in the selection windows in MAXQDA Stats will be exported as its own 

variable. The values of these variables corresponds to the occurrence of the codes in the relevant 

documents. 

Hint: Existing filenames cannot be overwritten, only saved under a new filename. 

When exporting data to SPSS the following should be taken into consideration: 

● Spaces and certain characters are permitted in MAXQDA but not in SPSS. In order to be SPSS 

compliant, variable names will be processed as follows:  

Blank space Will be replaced with underscore_ 

Begins with #  # will be replaced with HASH  

Begins with $  $ will be replaced with DOLLAR  

Is too long Will be shortened 

Is a reserved word _MQ will be attached as suffix 

Begins with an invalid character Character will be replaced with an x  

Forbidden character Will be replaced with a period, blank spaces with 

an underscore; if at end will be cut off  

 

● In order for the variable name to remain identifiable following the adaptation, a number may be 

added at the end. 

● For text variables, missing values will be exported only if none of the variable values is longer than 

8 bytes, otherwise SPSS will not accept any missing values for text variables. 
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7 Work with External Data in SPSS or Excel Format 

Open SPSS data  

To open and analyze an SPSS file with MAXQDA Stats, proceed as follows: 

● If MAXQDA Stats has not yet been launched, select the entry Stats > Start Stats with external 

file in the MAXQDA main menu. Then, select the appropriate file in the window that appears. 

● If MAXQDA Stats has already been launched, the external file can be selected directly from the 

main menu using the function File > Open external file. In MAXQDA Stats only one dataset can 

be open at a time, so Stats will ask if you would like to save the file that is already open or transfer 

it to MAXQDA, as the data matrix will no longer be available once the external file is open. 

When the external file is open, all Stats analysis functions are available. 

Hint: “Text” type variables in MAXQDA can only contain 63 characters. The content of string varia-

bles longer than 63 characters will be truncated upon import. 

Open an Excel file  

MAXQDA Stats can read Excel files of the following structure, which corresponds to that of the Data 

Editor: The column headers contain the variable names, and the cases form the rows:  

1 low 26 Seamstress 

2 high 33 Hairdresser 

3 medium 32 Mechatronics engineer 

4 medium 25 Graphic designer 

… … … … 

 

The first column ID is not required, but it is recommended to include a unique identification in the 

dataset in order to be able to definitively match the cases, especially if the data will later be analyzed 

in another program. 

Opening an Excel file is done in the same way as described above for SPSS files, via the MAXQDA 

main menu function Stats or directly in MAXQDA Stats using the File function. As no information on 

the variable type is contained in the Excel file, a dialog box will appear in Stats following the selection 

of the Excel file, in which the variable type can be defined. 
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Dialog box for specifying variable types upon import of an Excel 

Indicate which of the detected variables you wish to import by checking the boxes in the first column. 

In the “Variable type” column, define the variable types. The data pattern can be used as a helpful 

indication. 

Hint: Columns with an empty heading will be ignored and are not listed in the dialog. 

After clicking Import the Excel file will be read and all Stats analysis functions will be available. 

Hint: Upon import, variable names will be truncated to a maximum of 63 characters. Columns with 

variable names that already exist further left in the Excel file in an identical manner will be ignored 

upon import. 

Naturally, no information on missing values or value labels will be imported, because this type of 

information is not included in the Excel file. The measurement level will be set according to the vari-

able type: integer, floating point and date variables will be set at “interval”, whereas text and Boolean 

variables will be set at “nominal”. 

Create new External File 

In MAXQDA Stats, you can create new external data and store it in SPSS format, for example, results 

from a survey can be inputted and evaluated directly in MAXQDA Stats. 

● If MAXQDA Stats has not yet been launched, select Stats > Start Stats with new external file 

from the MAXQDA main menu. 

● If MAXQDA Stats has already been launched, create a new file directly from the main menu by 

selecting File > New external file. In MAXQDA Stats only one dataset can be open at a time, so 

Stats will ask if you would like to save the file that is already open or transfer it to MAXQDA, as 

the data matrix will no longer be available once the external file is open. 

MAXQDA Stats will open directly with an empty Variable List, in which you can insert new variables 

and subsequently enter values in the Data Editor. 
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Save External Data in SPSS Format  

To save a currently open file as an SPSS file (which can be read by several statistical packages), proceed 

as follows: 

1. Select the menu function File > Save as then, in the window that appears, specify a filename and 

location for the SPSS file. 

2. MAXQDA Stats will ask if you also wish to export the codes to SPSS. If you answer yes, each code 

that is available for analysis in the selection window in MAXQDA Stats will be exported as its own 

variable. The values of these variables corresponds to the occurrence of the codes in the relevant 

documents.  

Hint: Existing files cannot be overwritten, only saved with a new filename. This means each time you 

save your data a new file will be created. 

When exporting data to SPSS, the following should be taken into consideration: 

● Spaces and certain characters are permitted in MAXQDA but not in SPSS. In order to be SPSS 

compliant, variable names will be processed as follows:  

Blank space Will be replaced with underscore_ 

Begins with #  # will be replaced with HASH  

Begins with $  $ will be replaced with DOLLAR  

Is too long Will be shortened 

Is a reserved word _MQ will be attached as suffix 

Begins with an invalid character Character will be replaced with an x  

Forbidden character Will be replaced with a period, blank spaces with 

an underscore; if at end will be cut off  

 

● In order for the variable name to remain identifiable following the adaptation, a number may be 

added at the end. 

● For text variables, missing values will be exported only if none of the variable values is longer than 

8 bytes, otherwise SPSS will not accept any missing values for text variables. 
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8 Transform data 

Compute Variables  

With MAXQDA Stats you can perform calculations on a selected variable and store the result in a new 

variable. To begin the calculation, select the function Transform > Compute variable from the Stats 

main menu. The following window will appear: 

 

Window for calculation of new variables 

When calculating variables, proceed as follows: 

1. In the upper pane of the window, assign a new variable name and a label if required. If the variable 

name already exists, MAXQDA will indicate it in red. The newly created variable will automatically 

be assigned the type “Floating”. 

2. In the lower pane “Numerical expression”, assign an evaluation instruction. If the input cannot be 

evaluated, for example because a bracket or a summand is missing, MAXQDA will indicate so in 

blue as displayed in the screenshot. 
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In the “Variable” section, all “Integer” and “Floating point” type variables are listed. All variables are 

numbered consecutively from “V1” to “Vn”, with the variable name (or the label if present) enclosed 

in square brackets. When proceeding with the calculation, the identifier must be inputted as displayed 

in the screenshot above. 

Tip: Double-clicking a variable will insert it into the current cursor position, so it does not need to be 

entered manually. 

In the right hand pane, “Functions”, frequently used functions including the applied syntax are listed. 

Click the function buttons to insert the function in the calculation pane.  

+  -  *  / Add, subtract, multiply, divide  

^ Exponent, for example “V1^2” is the variable “V1” squared 

avg(a, b, …) Arithmetic mean of all variables or arithmetic expressions enclosed in the paren-

theses (separated by commas). Any number of variables or arithmetic expressi-

ons can be enclosed in the parentheses.  

sum(a, b, …) Sum of all variables or arithmetic expressions enclosed in the parentheses (sepa-

rated by commas). Any number of variables or arithmetic expressions can be en-

closed in the parentheses.  

sqrt(a) Root of the expression in parentheses 

round(a) The arithmetic expression in parentheses will be rounded to the next whole 

number  

roundn(a, decimals) The arithmetic expression in parentheses will be rounded to the specified num-

ber of decimal places  

 

When you click OK, the new variable will be calculated and displayed in the Data Editor. 

Hint: If one of the variable values in the calculation instruction is empty or defined as missing, a 

system-defined missing value will be entered for the result, and the cell will remain empty. 

You can also include if-then conditions in the calculation. The following examples illustrate the syntax 

to be used: 

if (V1 > V2) { 

   V1 

} 

else { 

   V2 

} 
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Alternative Syntax: 

if (V1 > V2) 

   V1; 

else 

   V2 

Recode Variables  

Often when working with datasets there is the desire to recode variables; for example, to reverse the 

polarity of an item or group multiple variables as a single variable, summarized as, for example, dif-

ferentiated collected information on schooling for three levels of education. MAXQDA Stats allows 

recoding of multiple variables or variable values at a time. 

Recode into New Variable 

Normally variable values are recoded as new variables so that the original value will not be affected. 

Proceed as follows: 

1. Begin the recoding process from the menu function Transform > Recode into new variable. 

2. The following window will appear: 

 

3. In the left hand pane, select the variables that you wish to recode. Double-click the desired variable 

to transfer it to the right-hand pane. Multiple variables can be transferred at a time by holding the 
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Ctrl/cmd key as the variables are selected, then moving them to the right pane with the mouse or 

by using the blue arrow in the center of the window. 

4. For the new variable name, MAXQDA Stats automatically suggests the original name supple-

mented with a number after a hashtag #. You can modify the name by editing it in the cell. 

5. When you click OK, a dialog box will appear for the input of the modified values: 

 

Dialog box for input of values to be recoded 

In the “Old value” column, enter the original value and in the “New value” column, enter the 

target value to be recoded. The image above shows a classic example: the value of the items is 

reversed, so that the lowest value of 1 becomes the highest value of 4, and vice versa. 

Using the selection list in the first column, you can specify a range of values to which a single new 

value will be assigned. In the selection list, the operators greater than (>); less than (<); greater 

than or equal to (≥); or lesser than or equal to (≤) are available. Using the following rows, a variable 

with a value of 3 can for example be dichotomized, so that in the new variable 0 is displayed for 

values under 3, and 1 is displayed for values over 3: 

 

The button Insert all existing values lists the occurring values for all selected variables, which is 

especially practical when all values of a variable will be recoded and you wish to immediately begin 

entering the new values. 

The  and  symbols allow you to delete individual or all rows. 
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6. When you click OK the new variable will be inserted and displayed in the Data Editor. The variable 

label will appear as the original supplemented with the suffix “recoded” so the recoded variable 

can be easily recognized. If no label is present, the variable name is used as a label to which “re-

coded” is added. 

MAXQDA Stats proceeds specifically as follows when recoding: 

● In case of conflict of the attribution, the lower attribution will be applied. For example, if the first 

row states “1 to 4” and the second row states “>0 to 3”, 1 will be recoded as 3 and not 4.  

● If no new value is specified for an existing value, the old value will be retained. 

● Value labels will not be transferred to the new variable, but the definitions for missing values. 

Recode Code Frequencies per Document as New Variables 

With MAXQDA Stats, you can not only recode variables, but also the code frequencies that were 

transferred from a MAXQDA project to MAXQDA Stats. If you launched MAXQDA Stats with the data 

from a MAXQDA project, click the “Code” tab in the dialog box to select individual codes from the 

familiar code tree. 

To recode a code as a new variable, double-click the code or drag it into the right pane of the window 

using the mouse. You can also use the blue arrow to transfer codes to the right pane. 

 

Select codes for recoding as new variables 

Assuming that you are only interested in whether or not a code has been assigned in a document, 

the exact number of code frequencies is not relevant, but only whether 0 or a higher number is 

displayed. In this case the code can be recoded in a single fow and stored as a new variable: 
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Recoding into the Same Variable 

Recoding into the same variable is performed in the same way as recoding into a new variable, from 

the menu Transform > Recode into same variable. However, for this procedure only variables, not 

codes, can be selected, and naturally the definition of a new variable name is omitted. 
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9 Frequency tables  

Create a new Frequency Table  

To create a new frequency table, proceed as follows: 

1. Select the menu function Descriptive Statistic > Frequencies. 

2. In the window that appears, select the variables for which you would like to create frequency 

tables: 

 

Variables can be selected in several ways: 

● Double-click on a variable. 

● Drag and drop the variable into the right window pane. 

● Select one or multiple variables with the mouse by holding the Ctrl/Cmd key then drag the 

selection into the right window pane with the mouse, or click the blue arrow in the middle of 

the window. 

3. Switch to the “Codes” tab and select the codes for which you would like to create frequency 

tables. (This function is available only when MAXQDA Stats is launched from a MAXQDA project). 
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When you click OK, MAXQDA Stats creates a frequency table and displays it in a results view. 

Results Table 

 

Results table for frequency 

The frequency table displays how many times the individual variables occur. For the variable “Job 

Security Scale” the value “low” was assigned in 45 cases, and the value “high” in 27 cases. The lower 

section of the table shows system-defined missing values (blank cells) as well as defined missing val-

ues. In the example above, there are 99 missing values, which occurred in 3 cases. 

Hint: If a value is defined in the individual missing values as well as in a range of missing values, it 

will be calculated only as an individual missing value. For example, if “99” is defined as missing and 

also “50 to 100”, “99” will be included in its own row and excluded from the range “50 to 100.“ 

Overview of Toolbar Functions 

In the upper section of the results window two toolbars are located, which contain the following 

important functions: 
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  Table view / Chart view – switches between table and chart view. 

  Previous/Next – using the blue arrow or the selection list, 

switch between the results table for previously selected variables or codes. 

  Refresh – Calls up again the dialog for creation of frequency tables. 

  Insert into output viewer – inserts the currently displayed table or chart in the Output Viewer. 

  Insert all into output viewer – inserts all created tables or charts in the Output Viewer. 

  Copy to clipboard – copies the current table, highlighted area in the table, or chart in the clip-

board, for example for insertion into Word. 

  Print – prints the currently displayed table or chart. 

  Export – exports the currently displayed table in Excel format, website (HTML) format or RTF 

format for Word and other word processing programs; exports the currently displayed chart in PNG, 

SVG or EMF (only Windows) format. 

  Show value labels – this option is selected by default and causes the defined value label of a 

variable to be displayed in the place of the value of the variable. 

  Descriptive statistics – this option is available only for integer and floating point type variables 

as well as for codes and displays a window with descriptive statistics for the displayed frequency 

tables. 

  Undo changes – step-by-step resetting of changes to a table (deletion of rows, merging and 

moving of rows). 

  Redo – step-by-step restoring of changes to a table. 

Sort Tables and Customize Columns 

Tables can be sorted by clicking a column header, in ascending order with the first click and descend-

ing order with the second. Clicking again will restore the original order. 

Tip: You can also move the rows of the results table. Click a row, then drag and drop with the mouse 

to the desired location. This function is also available for multiple highlighted rows. Lines containing 

totals or missing values cannot be moved. 

Column widths can be adjusted with the mouse, and their position can be changed by clicking the 

column header then dragging them to the desired location with the mouse. 

Delete Rows 

The results table is interactive and one or more rows can be removed, for example to restrict the 

evaluation to selected variables. Right-click a row and select Delete. You can also select multiple 

rows to delete by holding down the Ctrl/cmd key. 
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In this way, you can also remove the missing values from the display: 

 

Delete rows from the results table using the context menu 

The table will be automatically updated. 

Tip: A column can be hidden from the table by right-clicking within the column header and selecting 

Hide column. When the frequency function is called up the next time, the column will be automat-

ically displayed again. 

Merge Values  

The interactive results table also allows you to merge multiple values: 

1. Highlight at least two rows by holding down the Ctrl/cmd key as you click on the desired rows 

with the mouse. 

2. Right-click the selection and select Merge values. 

In the following example, the two lowest values for the variable “Job Security Scale” are merged: 

 

Merge multiple values using the context menu 

The table will be automatically updated. 

Save Documents as Document Set  

If MAXQDA Stats is launched with the data from a MAXQDA project, the frequency of individual 

variable values corresponds to the number of documents in which these variable values occurred. In 

this case, a compilation of documents is present behind each frequency count. This compilation of 

documents can be saved as a document set in MAXQDA: Right-click on a row and select Save as 

document set. 
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Store documents that are attached to a variable value as a document set in MAXQDA 

Initially, MAXQDA stores such sets in the background. When you exit Stats, all document sets created 

during the analysis will be displayed, so you can select which document sets you wish to transfer to 

the MAXQDA project. 

 

Select document sets upon exiting MAXQDA Stats 

Calculate Descriptive Statistics for Frequency Tables 

It is possible to request a table with the measures of the descriptive statistics for all frequencies of 

integer or floating-point type as well as for codes. When you click the  Descriptive Statistics sym-

bol the following window will appear, which contains typical measures for descriptive statistics. 
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Descriptive Statistics for a variable 

When you click the Copy button, the table will be transferred to the clipboard for insertion into 

programs such as Word. 

Transfer Results Table to Output Viewer 

After the tables have been created and adapted according to your needs, they can be transferred to 

the Output Viewer from which they can later be exported together: 

● Click the Insert into output viewer  icon to transfer the currently displayed results table to the 

Output Viewer. 

● Click the Insert all result tables into output viewer  icon to transfer all frequency tables to 

the Output Viewer. 

If at least one of the tables was created for an integer or floating-point variable or a code, MAXQDA 

Stats will ask if you also wish to insert the descriptive statistics into the Output Viewer. If you agree, 

a table containing the descriptive statistics will be displayed below the results table. 

Tip: When the table is transferred, the adjusted column widths will be maintained. 
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Frequency table in the Output Viewer following transfer 

Export and Print Results Table 

Several options for exporting and printing the currently displayed results table are available using the 

following symbols: 

  Copy to clipboard – copies the entire table or selection to the clipboard, for example in order to 

paste it directly into Word. 

  Print – starts the print process and displays a print preview, in which the settings such as margins, 

orientation, headers and footers can be applied. 

  Export – exports the table in Excel format, website (HTML) format or RTF format for Word and 

other word processing programs. 
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Display Frequencies as Charts 

Frequency tables can be displayed as column, bar, or pie charts. You can switch between chart and 

table views using the  and  icons. 

 

Frequency chart 

You can customize the chart design and display by using the icons in the toolbar above the chart, as 

well as double-clicking and right-clicking on the elements of the chart. The size of the chart automat-

ically adjusts to the window size. Enlarge the window to get a larger chart. 

Hint: At maximum, the first 20 entries of the frequency table will be displayed in the chart. 

Frequency charts can be transferred to the Output Viewer for later export. In order to do so, use the 

following icons. 

  Insert chart into output viewer, to insert only the current display 

  Insert all charts into output viewer, to insert charts for all created frequency tables at the same 

time. 

Hint: Charts will be inserted into the Output Viewer in the size that they are displayed, to a maximum 

width of 650 pixels. 

To export or print a chart directly, you can use the usual icons in the top right of the window: 

  Copy to clipboard,   Print and   Export. 
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10 Descriptive Statistics  

With MAXQDA Stats you can calculate various measures of descriptive statistics for several variables 

simultaneously, and compare results in an easy-to-read table. Begin the evaluation using the Descrip-

tive Statistic > Descriptive Statistics menu. The following window will appear, where you can select 

all the desired variables and codes. In the window, only integer or floating point variables will be 

displayed: 

 

Select codes, variables and options for Descriptive Statistics 

Variables can be selected in several ways: 

● Double-click on a variable. 

● Drag and drop the variable into the right window pane. 

● Select one or multiple variables with the mouse by holding the Ctrl/Cmd key then drag the selec-

tion into the right window pane with the mouse, or click the blue arrow in the middle of the 

window. 

To generate descriptive statistics for code frequencies per document, switch to the “Codes” tab and 

select the desired codes. (This option is available only if MAXQDA Stats was launched with the data 

of a MAXQDA project). 

In the right pane of the window you can select typical metrics and values for the descriptive statistics, 

some of which require further explanation: 
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1st and 3rd Quartile – The first quartile corresponds to the 25 percentile and indicates the value 

below which 25 % of all values fall. Accordingly, 25% of all values are greater than the value of the 

third quartile, that is the 75th percentile. There are various methods to determine the percentile of a 

distribution of measured values. A review of nine different methods can be found in Hyndman & Fan 

(1996): “Sample quantiles in statistical packages”. In MAXQDA Stats method no. 7 is implemented, 

which is also the default method used by “r”. 

Standard deviation (sample) vs. (population) – for the standard deviation of population the unbi-

ased estimator is calculated by dividing the sum of squares by (n - 1), while selecting “sample” the 

sum is divided by n. The same applies to the calculation of the variance. 

Mean error – the standard error of the mean value is output, which is estimated from the random 

sample. When several samples are taken from a population, the means of these samples scatter 

around the true mean of the population. This scattering is called mean error. 

95% confidence interval for mean – Using the mean error, the limits of the interval are calculated 

and displayed, which represent a 95% probability of the population mean. 

In the lower section of the window, the following options are available: 

Exclude cases listwise – select this option to include only cases for which all selected variables have 

a valid value. 

Save standardized z-values in new variables – Check this option to perform a z-standardization 

of values for all selected variables and codes, and store the results in the new variables. The original 

variable name is used, supplemented by the suffix "_zvalues”. Existing variable labels are also used 

and supplemented by the suffix (z-standardized). If no variable label was present, the variable name 

is entered as a label. 

Hint: For calculation of z-values the standard deviation (population) with denominator (n – 1) is used. 

Results tables 

After beginning the evaluation by clicking OK the following results table appears, in which the se-

lected variables and codes form the rows and the selected measures form the columns: 

 

Results table for the “Descriptive Statistics” function 
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The result table always contains the column “N” with the number of valid cases (far left) and the 

column “Missing” and “Missing (%)” (far right), which provide information on the absolute and 

relative proportion of missing values for each variable. When the “Exclude cases listwise” option is 

selected, the missing values are all identical. In the example above, code frequencies were evaluated, 

among which there were no defined missing values, therefor the last two columns contain null values. 

Sort Tables and Customize Columns 

Tables can be sorted by clicking a column header, in ascending order with the first click and descend-

ing order with the second. Clicking again will restore the original order. 

Tip: You can also move the rows of the results table. Click a row, then drag and drop with the mouse 

to the desired location. This function is also available for multiple highlighted rows. Lines containing 

totals or missing values cannot be moved. 

Column widths can be adjusted with the mouse, and their position can be changed by clicking the 

column header then dragging them to the desired location with the mouse. 

Delete Rows (Variables) 

The results table is interactive and one or more rows (variables) can be removed. Right-click 

a row and select Delete. You can also select multiple rows to delete by holding down the 

Ctrl/cmd key. When a variable is deleted from the table the table will not be recalculated, 

even if the Exclude cases listwise option was selected and the number of the valid values 

would change. 

Tip: Columns can be hidden from the table, by right-clicking on the column header and selecting the 

Hide column option. The next time the function is called up, the column will automatically be dis-

played. 

Transfer Results Table to the Output Viewer 

Once the tables have been created and adapted according to your needs, they can be transferred to 

the Output Viewer by clicking the Insert into Output Viewer  icon, which allows the tables to 

later be exported along with other results. 

Tip: Upon transfer, modifications to column width will be maintained. 
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Frequency table following transfer to the Output Viewer 

Export and Print Results Table 

Several options for exporting and printing the currently displayed results table are available using the 

following symbols: 

  Copy to clipboard – copies the entire table or selection to the clipboard, for example in order to 

paste it directly into Word. 

  Print – starts the print process and displays a print preview, in which the settings such as margins, 

orientation, headers and footers can be applied. 

  Export – exports the table in Excel format, website (HTML) format or RTF format for Word and 

other word processing programs. 
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11 Crosstabs  

Create a New Crosstab  

In order to create a new crosstab select Compare Groups > Crosstabs in the main menu of 

MAXQDA Stats. A window appears that allows you to determine rows and columns for the 

crosstab. 

 

Dialog box for selection of rows and columns in the crosstab 

Variables can be selected in several ways: 

● Double-click on a variable. 

● Drag and drop the variable into the right window pane. 

● Select one or multiple variables with the mouse by holding the Ctrl/Cmd key then drag the selec-

tion into the right window pane with the mouse, or click the blue arrow in the middle of the 

window. 
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To integrate code frequencies per document in the crosstab, switch to the “Codes” tab and select 

the desired codes. (This option is available only if MAXQDA Stats was launched with the data of a 

MAXQDA project). 

Results Table 

After starting the calculation by clicking OK a crosstab will be computed for each combination of 

rows and columns variables. The figure above shows a selection for which four crosstabs will be 

created. Following results table appears that allows you to switch between the single crosstabs by 

using the blue arrows and the drop down menu at the top of the window. 

 

Results table for the function “crosstabs” 

The number of valid and missing values for the displayed variable combination is shown in the upper 

right corner. 

Selecting displayed values  

If you start the function “crosstabs” the numbers in the cells display the absolute frequencies, thus 

the number of cases for each combination of variable values. You can switch the display for the cells 

to the following values: 

● Relative frequencies – percentage based on all valid values 

● Row percentage – percentage based on the sum of a row 

● Column percentages – percentage based on the sum of a column 

● Expected frequencies – expected frequencies in case of independence of both variables 

● Residuals – differences between observed absolute frequencies and the expected. In case 

of positive residuals more cases occurred than it would be expected considering the marginal dis-

tributions. 



Crosstabs 50 

Standardized residuals – in order to gain a better comparability the residuals are divided by 

the root of the expected frequencies. The standardized residuals’ magnitude corresponds to 

the root of the particular cell’s Chi-square. 

Corrected standardized residuals – the standardized residuals are adjusted on the basis of 

the marginal frequencies. 

The cells of the crosstab display either one or two of the presented values. Use the drop down menu 

on the top of the chart to select the values you want to display. 

 

Setting the content for the cells 

Highlighting cells with high standardized residuals  

You can use standardized residuals for the exploratory interpretation of the table. This is possible 

because based on the assumption of the independency of the two tabulated variables the standard-

ized residuals are asymptotically normally distributed. Accordingly, a standardized residual greater 

than 2 or less than -2 indicates an unexpected high or low number of observations in the cell. Values 

that exceed the magnitude of 2.6 are even less to expect. 

Click on the icon Highlight cells with high standardized residuals . Now MAXQDA Stats high-

lights all cells with a standardized residual greater than 2 in blue and all cells with values smaller than 

2 in red. If there are values which magnitude is greater than 2.6 the cells are additionally displayed 

darker. 

 

Crosstab with highlighted cells for easier interpretations 
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Overview of Toolbar Functions 

In the upper section of the results window two toolbars are located, which contain the following 

important functions: 

  Previous/Next – using the blue arrow or the selection list, 

switch between the created crosstabs table. 

  Refresh – Calls up again the dialog for creation of crosstabs. 

  Insert into output viewer – inserts the currently displayed table in the Output Viewer. 

  Insert all into output viewer – inserts all created tables in the Output Viewer. 

  Copy to clipboard – copies the current table or the highlighted area in the table in the clipboard, 

for example for insertion into Word. 

  Print – prints the currently displayed table. 

  Export – exports the currently displayed table in Excel format, website (HTML) format or RTF 

format for Word and other word processing programs; exports the currently displayed chart in PNG, 

SVG or EMF (only Windows) format. 

  Show value labels – this option is selected by default and causes the defined value label of a 

variable to be displayed in the place of the value of the variable. 

  Highlight cells with high standardized residuals – switch on this option for highlighting cells, 

which magnitudes of standardized residuals are greater than 2 for easy interpretation of the results. 

  Association measures – opens a window with association measures for the two variables dis-

played in the actual crosstab. 

  Undo changes – step-by-step resetting of changes to a table (deletion of rows, merging and 

moving of rows). 

  Redo – step-by-step restoring of changes to a table. 

Sort Tables and Customize Columns 

Tables can be sorted by clicking a column header, in ascending order with the first click and descend-

ing order with the second. Clicking again will restore the original order. 

Tip: You can also move the rows of the results table. Click a row, then drag and drop with the mouse 

to the desired location. This function is also available for multiple highlighted rows. Lines containing 

totals or missing values cannot be moved. 

Column widths can be adjusted with the mouse, and their position can be changed by clicking the 

column header then dragging them to the desired location with the mouse. 
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Delete Rows or Columns 

The results table is interactive and one or more rows can be removed, for example to restrict the 

evaluation to selected variables. Right-click a row and select Delete. You can also select multiple rows 

to delete by holding down the Ctrl/cmd key. 

 

Delete a row from the results table using the context menu 

To delete a column from the results table right click on its heading and select Delete. 

The table will be automatically updated after deletion of rows or columns. 

Merge values  

The interactive results table also allows you to merge multiple values: 

1. Highlight at least two rows by holding down the Ctrl/cmd key as you click on the desired rows 

with the mouse. 

2. Right-click the selection and select Merge values. 

In the following example, the two values “married” and “partner” are merged: 

 

Merge multiple values using the context menu 
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Columns can be merged, too: 

1. Right-click on a column heading and select Merge values.  

2. A popup menu appears containing all other columns of the crosstab. Click on one of the dis-

played columns to merge it with the right-clicked column. 

The table will be automatically updated after merging columns or rows. 

Save Documents as Document Set  

If MAXQDA Stats is launched with the data from a MAXQDA project, the frequency in a cell corre-

sponds to a compilation of documents in which the combination of variable values occurs. This com-

pilation of documents can be saved as a document set in MAXQDA: Right-click on a row and select 

Save as document set. 

 

Store documents that are attached to a combination of variable value as a document set in MAXQDA 

Initially, MAXQDA stores such sets in the background. When you exit Stats, all document sets created 

during the analysis will be displayed, so you can select which document sets you wish to transfer to 

the MAXQDA project. 

 

Select document sets upon exiting MAXQDA Stats 



Crosstabs 54 

Calculating Measures of Association for Crosstabs  

In order to calculate measures of association and Chi-square values for a crosstab click the icon As-

sociation measures  in the toolbar above the crosstab. 

 

Icon for calling a window with measures of association of a crosstab 

 

Measures of association for a crosstab  

Following measures are computed (see textbooks on statistic for interpretation): 

● Pearson’s Chi-square with degrees of freedom for the crosstab and the asymptotic two-sided sig-

nificance level. 
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● Number of cells with expected frequencies smaller than 5 as well as the minimum expected fre-

quency. 

● Coefficient of contingency 

● Cramer’s V 

As you can see in the example above, additional measures are calculated in fourfold tables: 

● Pearson’s Chi-square with continuity correction 

● Phi 

If you click Copy the table will be transferred to the clipboard so you can paste the table easily into 

other programs such as Word. 

Transfer Results Table to the Output Viewer 

After the tables have been created and adapted according to your needs, they can be transferred to 

the Output Viewer from which they can later be exported together: 

● Click the Insert into output viewer  icon to transfer the currently displayed results table to the 

Output Viewer. 

● Click the Insert all result tables into output viewer  icon to transfer all created tables to the 

Output Viewer at once. 

MAXQDA Stats will ask if you also wish to include the measures of association. If you agree, a table 

containing the measures will be displayed below the results table. 

Tip: When the table is transferred, the adjusted column widths will be maintained. 
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Crosstab following transfer to the Output Viewer 

Export and Print Results Table 

Several options for exporting and printing the currently displayed results table are available using the 

following symbols: 

  Copy to clipboard – copies the entire table or selection to the clipboard, for example in order to 

paste it directly into Word. 

  Print – starts the print process and displays a print preview, in which the settings such as margins, 

orientation, headers and footers can be applied. 

  Export – exports the table in Excel format, website (HTML) format or RTF format for Word and 

other word processing programs. 
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12 One-Way Analysis of Variance  

In order to compute a one-way analysis of variance with MAXQDA Stats, select Compare Groups > 

Analysis of Variance in the main menu. A window appears that allows you to select several 

dependent variables and one factor as independent variable.  

 

Dialog box for the selection of the dependent variables and the factor for the variance analysis 

Variables can be selected in several ways: 

● Double-click on a variable. 

● Drag and drop the variable into the right window pane. 

● Select one or multiple variables with the mouse by holding the Ctrl/Cmd key then drag the selec-

tion into the right window pane with the mouse, or click the blue arrow in the middle of the 

window. 

To integrate code frequencies per document as dependent variables or as a factor, switch to the 

“Codes” tab and select the desired codes. (This option is available only if MAXQDA Stats was 

launched with the data of a MAXQDA project). 

Hint: You can only select variables of the type integer or float as dependent variable. 
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In order to integrate only those cases that contain variables with a valid value select Exclude cases 

listwise. 

Results Table 

After starting the calculation by clicking OK an analysis of variance is performed for each selected 

dependent variable. The following results table appears for the first dependent variable. Use the blue 

arrows and drop down menu on the top of the window to switch to results tables for the other 

dependent variables. 

 

Results table for the function “analysis of variance” 

The number of valid and missing cases for each calculated variance analysis is displayed in the upper 

right corner. The results table includes all the major results of the variance analysis. 

● The column “sum of squares” contains the sum of squares between groups and within groups. 

● The column “df” provides information on the number of degrees of freedom and allows conclu-

sions on the number of groups that are defined by the factor. The example shows 3 +1 = 4 groups. 

● The “mean squares” can be calculated by dividing the sum of squares by the degrees of freedom. 

The ratio of mean squares in turn results the “F-value” whose probability of occurrence can be 

computed by using the F-distribution and finds expression in the “p-value”. 

● “Eta-squared” is a measure of effect size and signifies the variance explained by the factor. The 

value is between 0 and 1 and can be interpreted as a percentage. 

Testing the homogeneity of variances  

A prerequisite for the calculation of a variance analysis is the homogeneity of variance within the 

single factor levels. This can be tested with the Levene test, the results are displayed in the lower part 

of the table. 
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Overview of Toolbar Functions 

In the upper section of the results window two toolbars are located, which contain the following 

important functions: 

  Table view / Chart view – switches between table and chart view for means. 

  Previous/Next – using the blue arrow or the selection list, 

switch between the results table for the dependent variables. 

  Refresh – Calls up again the dialog for selecting variables for analysis of variance. 

  Insert into output viewer – inserts the currently displayed table or chart in the Output Viewer. 

  Insert all into output viewer – inserts all created tables or charts in the Output Viewer. 

  Copy to clipboard – copies the current table, highlighted area in the table, or chart in the clip-

board, for example for insertion into Word. 

  Print – prints the currently displayed table or chart. 

  Export – exports the currently displayed table in Excel format, website (HTML) format or RTF 

format for Word and other word processing programs; exports the currently displayed chart in PNG, 

SVG or EMF (only Windows) format. 

  Descriptive statistics – opens a window containing descriptive values for the groups build by the 

factor. 

  Undo changes – step-by-step resetting of changes to a table (deletion of rows). 

  Redo – step-by-step restoring of changes to a table. 

Display Descriptive Statistics 

If you want to display important characteristic values for each factor level click on the icon Descriptive 

statistics .  A table appears containing information for each factor level and the total number of 

cases. 

 

Descriptive statistics for each factor level 
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● Column„N“ shows the number of valid values for each factor level. 

● Column „Mean lower bound (95%)“ contains the lower value of the confidence interval on the 

mean. 

Transfer Results Table to the Output Viewer 

After the tables have been created, they can be transferred to the Output Viewer from which they 

can later be exported together: 

● Click the Insert into output viewer  icon to transfer the currently displayed results table to the 

Output Viewer. 

● Click the Insert all result tables into output viewer  icon to transfer all created tables to the 

Output Viewer at once. 

MAXQDA Stats will ask if you also wish to include a descriptive statistic for the factor groups. If you 

agree, an additional table will be displayed below the results table. 

Tip: When the table is transferred, the adjusted column widths will be maintained. 

 

Results table following transfer to the Output Viewer 

Export and Print Results Table 

Several options for exporting and printing the currently displayed results table are available using the 

following symbols: 

  Copy to clipboard – copies the entire table or selection to the clipboard, for example in order to 

paste it directly into Word. 
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  Print – starts the print process and displays a print preview, in which the settings such as margins, 

orientation, headers and footers can be applied. 

  Export – exports the table in Excel format, website (HTML) format or RTF format for Word and 

other word processing programs. 

Display Means as Chart 

In order to display a chart of the means of the single factor groups click the icon  Chart view in 

the results table. 

 

Chart view of the means 

You can customize the design and view of the chart by using the icons in the toolbar above the chart 

as well as double-clicking and right-clicking the elements of the chart. The chart’s size automatically 

adjusts to the window size. Enlarge the window in order to receive a larger chart. 

Hint: In case of the occurrence of negative means no chart is displayed. 

Mean charts can be transferred to the Output Viewer for later export. In order to do so, use the 

following icons. 

  Insert chart into output viewer, to insert only the current display 

  Insert all charts into output viewer, to insert mean charts for all created result tables at the 

same time. 

Hint: Charts will be inserted into the Output Viewer in the size that they are displayed, to a maximum 

width of 650 pixels. 
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To export or print a chart directly, you can use the usual icons in the top right of the window: 

  Copy to clipboard,   Print and   Export. 
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13 Correlation  

Correlation analysis is used to examine relationships between variables, in particular the analysis of 

“the more, the more”- and “the more, the less”-correlations. MAXQDA Stats supports the calculation 

of bivariate correlations, thus the correlation between two variables.  

In order to calculate a correlation with MAXQDA Stats, select one of the following items in the main 

menu: 

● Correlation > Pearson, usually used for interval scale variables or 

● Correlation > Spearman, usually used for ordinal scale variables 

A dialog box appears that allows you to select every variable that you want to calculate bivariate 

correlations for. 

Hint: All variables of the type float and integer are throughout available, regardless of the   level of 

measurement of single variables. 

 

Dialog box for selecting variables to calculate correlation (here: Pearson’s r) 

Variables can be selected in several ways: 

● Double-click on a variable. 

● Drag and drop the variable into the right window pane. 
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● Select one or multiple variables with the mouse by holding the Ctrl/Cmd key then drag the selec-

tion into the right window pane with the mouse, or click the blue arrow in the middle of the 

window. 

To integrate code frequencies per document into the computation of correlations, switch to the 

“Codes” tab and select the desired codes. (This option is available only if MAXQDA Stats was 

launched with the data of a MAXQDA project). 

Results Table 

After clicking OK a results table appears containing the pairwise correlations. Since all selected varia-

bles are listed in both, rows and columns, all the calculated correlations are displayed twice. 

 

Results table with pairwise correlations (here: Pearson’s r) 

Each row contains three kinds of data:  

● The calculated correlation coefficient, either Pearson’s r or Spearman’s Rho, depending on the 

selected function, 

● the p-value for the correlation coefficient’s significance as well as 

● the number of valid cases for each combination of both variables. 

The picture above shows the correlation between the variables “Age” and “Life Satisfaction Index”  

which is highlighted in green. In this example, Pearson’s r is 0.242, the p-value is 0.0153 (thus below 

the significance threshold of 5%). The number of valid values for this combination of variables adds 

up to 80 cases. 

The one-sided p-value is displayed by default. Using the drop down menu in the toolbar it is possible 

to switch to two-sided p-values. The p-value is calculated if the number of cases is more than 5. If 

there are less cases the p-value is always 1. 

Hint: If the option Exclude cases listwise is selected the number of valid and missing values is dis-

played only in top right in the window. The cells contain the correlation coefficient and the p-value 

only. 
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Highlighting Significant Correlations 

In order to highlight every cell with a p-value under 5% in green click the symbol Highlight signifi-

cant correlations . The smaller the p-value the darker the background colors:  

● smaller than 5%  light green 

● smaller than 1%  green 

● smaller than 0,1%  dark green 

Overview of Toolbar Functions 

In the upper section of the results window two toolbars are located, which contain the following 

important functions: 

  Table view / Chart view – switches between the result table and scatter plots. 

  Refresh – Calls up again the dialog for selection of variables for the correlation table. 

  Insert into output viewer – inserts the currently displayed table or chart in the Output Viewer. 

  Copy to clipboard – copies the current table, highlighted area in the table, or chart in the clip-

board, for example for insertion into Word. 

  Print – prints the currently displayed table or chart. 

  Export – exports the currently displayed table in Excel format, website (HTML) format or RTF 

format for Word and other word processing programs; exports the currently displayed chart in PNG, 

SVG or EMF (only Windows) format. 

  Highlight significant correlations – switch on this option for highlighting cells with p-values 

lower than 5%. 

  Undo changes – step-by-step resetting of changes to a table (deletion of rows). 

  Redo – step-by-step restoring of changes to a table. 

Sort Tables and Customize Columns 

Tables can be sorted by clicking a column header, in ascending order with the first click and descend-

ing order with the second. Clicking again will restore the original order. 

Tip: You can also move the rows of the results table. Click a row, then drag and drop with the mouse 

to the desired location. This function is also available for multiple highlighted rows. Lines containing 

totals or missing values cannot be moved. 
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Column widths can be adjusted with the mouse, and their position can be changed by clicking the 

column header then dragging them to the desired location with the mouse. 

Delete Rows and Columns 

The results table is interactive and one or more rows can be removed. Right-click a row and select 

Delete. You can also select multiple rows to delete by holding down the Ctrl/cmd key. Right-click a 

column heading and select Delete to remove it from the results table. 

Deleting a column or row in a correlation table only affects the display. The values are not recalculated 

even if selected option Delete cases listwise would change the number of valid values for variables 

taken into account. 

Tip: A column can be hidden from the table by right-clicking within the column header and selecting 

Hide column. When the function is called up the next time, the column will be automatically dis-

played again. 

Transfer Results Table to the Output Viewer 

After the tables have been created, they can be transferred to the Output Viewer from which they 

can later be exported together: 

● Click the Insert into output viewer  icon to transfer the currently displayed results table to the 

Output Viewer. 

● Click the Insert all result tables into output viewer  icon to transfer all created tables to the 

Output Viewer at once. 

MAXQDA Stats will ask if you also wish to include a descriptive statistic for the factor groups. If you 

agree, an additional table will be displayed below the results table. 

Tip: When the table is transferred, the adjusted column widths will be maintained. 
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Results table for correlations following transfer to the Output Viewer 

Export and Print Results Table 

Several options for exporting and printing the results table are available using the following symbols: 

  Copy to clipboard – copies the entire table or selection to the clipboard, for example in order to 

paste it directly into Word. 

  Print – starts the print process and displays a print preview, in which the settings such as margins, 

orientation, headers and footers can be applied. 

  Export – exports the table in Excel format, website (HTML) format or RTF format for Word and 

other word processing programs. 

Displaying Scatter Plots  

In order to display a scatter plot for every pairwise combination of variables click on the  Chart 

view symbol in the results table. 
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Scatter plot for two variables 

Using the two drop down menus in the top toolbar you can determine the variables for the X-axis 

and the Y-axis. The drop down menus contain all the variables that are selected for the calculation of 

correlation. 

 

Determine variables for the X-axis and Y-axis 

It is not possible to customize the display of the chart. The chart’s size automatically adjusts to the 

window size. Enlarge the window in order to receive a larger chart. 

Scatter plots can be transferred to the Output Viewer for later export. In order to do so, use the 

following icons. 

  Insert chart into output viewer, to insert only the current display 

  Insert all charts into output viewer, to insert mean charts for all created result tables at the 

same time. 

Hint: Charts will be inserted into the Output Viewer in the size that they are displayed, to a maximum 

width of 650 pixels. 

To export or print a chart directly, you can use the usual icons in the top right of the window: 

  Copy to clipboard,   Print and   Export. 
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14 Scale  

MAXQDA Stats supports the creation of a scale, that consists of several items. Before you start build-

ing a scale, it may be helpful to check the items for consistent polarity, otherwise the computation 

may give wrong results. You can use the function Transform > Recode into other variable to stand-

ardize the item polarity.  

To build a scale in MAXQDA Stats, select the function Scale > Reliability (Cronbach’s Alpha) from 

the main menu. A dialog will appear in which you can select all the variables you want to include in 

the initial scale. 

Hint: The dialog contains all variables of type integer or floating point, independent from their meas-

ure. 

 

Dialog box for selection of variables for building a scale 

Variables can be selected in several ways: 

● Double-click on a variable. 

● Drag and drop the variable into the right window pane. 

● Select one or multiple variables with the mouse by holding the Ctrl/Cmd key then drag the selec-

tion into the right window pane with the mouse, or click the blue arrow in the middle of the 

window. 

To integrate code frequencies per document into the calculations, switch to the “Codes” tab and 

select the desired codes. (This option is available only if MAXQDA Stats was launched with the data 

of a MAXQDA project). 

Hint: Only those cases will be taken into account, where all variables have a valid value. 
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Results Table 

After click on OK MAXQDA Stats will compute a results table with the following structure: 

 

Result table for function “Scale” 

The results table contains the following information: 

● Cronbach’s Alpha and the number of Valid and Missing cases are displayed at the top right. 

● Item – This column contains the variable label, or if this does not exist, the variable name. 

● Mean scale w/o item – The “Mean value of the scale without the item” equates the mean value 

of the additive scale, if the item would be removed from the scale. 

● Std.dev. scale w/o item – The “Standard deviation of the scale without the item” equates the 

standard deviation (population) of the additive scale, if the item would be removed from the scale. 

● Corrected item scale corr. – The “Corrected item scale correlation” measures, how strongly the 

respective item correlates with the total scale. Usually, items with a very low correlation are not 

suitable for the final scale and should be removed from the item pool. MAXQDA Stats highlights 

the item(s) with the lowest correlation always. 

● Alpha w/o item – “Cronbach’s Alpha without item” informs about the height of Alpha, if you 

would remove the respective item from the scale. For the twelve items above, Cronbach’s Alpha 

is 0.773 for example. If you removed item no. 9 with the lowest item scale correlation, Alpha 

would be slightly increase to 0.782. 

Hint: Items with a negative item scale correlation usually have the wrong polarity which conflicts with 

the model assumptions for calculation of Cronbach’s Alpha. 
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Overview of Toolbar Functions 

  Refresh – Calls up again the dialog for selection of variables. 

  Insert into output viewer – inserts the currently displayed table in the Output Viewer. 

  Copy to clipboard – copies the current table or highlighted area in the table in the clipboard, for 

example for insertion into Word. 

  Print – prints the currently displayed table. 

  Export – exports the currently displayed table in Excel format, website (HTML) format or RTF 

format for Word and other word processing programs. 

  Remove item from scale – the selected items will be removed from the scale and the values of 

the results table are updated. 

 Build scale and save as new variable – shows a dialog in which you can set a variable name and 

a label for a new variable that contains either the sum or the mean of the item values for each case. 

  Descriptive statistics – opens a window containing descriptive values for each item and the total 

scale build by item summation or item means. 

  Undo changes – step-by-step resetting of changes to a table (deletion and moving of rows). 

  Redo – step-by-step restoring of changes to a table. 

Interactive Optimization of Scale by Deleting Items 

In MAXQDA Stats you can remove items from the scale, which leads to an immediate recalculation 

of all values: 

1. Click on an item (or some when holding down Ctrl/cmd key), you want to remove. 

2. Then click on the symbol  Remove item from scale or right click on the highlighted rows 

and select Remove from the context menu. 

MAXQDA Stats updates the values in the table instantly. 

To reintegrate a deleted item into the scale, you can click on the Undo symbol . 
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Result table for reliability analysis after removing an item 

Hint: For calculating the results for the remaining items MAXQDA Stats practices list wise deletion 

for cases with missing values. Therefore, the number of missing values may decrease and more cases 

might be integrated into the calculation. As a consequence, the new value for Cronbach’s Alpha 

might be slightly lower than the value displayed in the column “Alpha w/o item” before. 

Show Descriptive Statistics for Items and Total Scale 

For evaluation purpose of the frequency distributions, you can get an overview of descriptive statistics 

for the single items and the total scale build by addition and by mean: click on the symbol Descriptive 

Statistics  to start a calculation of typical statistical values. A window like the following will appear: 

 

Descriptive values for the single items of a scale and the total scale 
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The last two rows contain the values for the total scale. For the row “TOTAL SCALE (summation)” at 

first a variable will be computed in the background, which contains the sum of each item value for 

each case. Then the statistical values for this variable will be calculated. For the row “TOTAL SCALE 

(mean)” at first a variable is calculated, which contains the mean for each case. 

Build Scale and Save as New Variable  

MAXQDA Stats offers an easy possibility to combine the items shown in the result table in a scale and 

save it as a new variable. Click on the symbol Build scale and save as new variable  to start the 

calculation. A dialog will appear, in which you can enter a variable name and a variable label and 

where you can set the kind of calculation. 

 

Define variable name, variable label, and the kind of calculation for the new variable 

Summation – The sum of all single item values will be calculated for a case. 

Mean – The arithmetic mean of all single item values will be calculated for a case. 

If a value is missing for an item or the value is defined as a missing value, the newly created variable 

contains a (system defined) missing value for the respective case. 

Transfer Results Table to the Output Viewer 

To transfer the results table containing the computed values for the scale to the Output Viewer, click 

the Insert into output viewer  icon in the toolbar. 

MAXQDA Stats will ask if you also wish to include descriptive statistics in the Output Viewer. If you 

agree, an additional table will be displayed below the results table. 

Tip: When the results table is transferred, the adjusted column widths will be maintained. 
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Results table for “Scale” following transfer to the Output Viewer 

Export and Print Results Table 

Several options for exporting and printing the results table are available using the following symbols: 

  Copy to clipboard – copies the entire table or selection to the clipboard, for example in order to 

paste it directly into Word. 

  Print – starts the print process and displays a print preview, in which the settings such as margins, 

orientation, headers and footers can be applied. 

  Export – exports the table in Excel format, website (HTML) format or RTF format for Word and 

other word processing programs. 
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15 Limits and Technical Notes  

max. 1,000 

If you start Stats from within a MAXQDA project file, only the first 

1,000 variables and codes will be transferred to Stats. If you open an 

external file a maximum of 1,000 variables will be imported. 

There is no functional limit for the number of cases. Please keep in 

mind, that importing a large number of variables and cases will take 

some time. 

max. 63 characters 

“Round half to even” method is used for displaying floating num-

bers in Data Editor and Result Views, while “Round half up” method 

is used when choosing method round() for calculating new variables 

via the Transform menu (see https://en.wikipe-

dia.org/wiki/Rounding) 

There are different procedures to compute quartiles, as described in 

Hyndman & Fan (1996) „Sample quantiles in statistical packages”. In 

MAXQDA Stats procedure no. 7 is implemented, which is used by 

default by statistical package “r”, too. 

Stats supports the import of SPSS files created with version 18, in 

single cases files created with older version can be imported. 

The files exported in SPSS format can be opened with SPSS 18 or ne-

wer, depending on the content in single cases with older versions, 

too. 

When exporting to the older Excel format XLS a maximum of 256 

variables will be exported, because the format does not support 

more than 256 columns. 

 


